# Table of Contents

TABLE OF CONTENTS.....................................................................................................................2  
ABOUT THIS MANUAL ...........................................................................................................................5  
1.    INTRODUCTION ..............................................................................................................................5  
2.    CONVENTIONS AND TERMINOLOGY ...........................................................................................5  
   2.1.    CONVENTIONS .........................................................................................................................5  
          2.1.1. References ...........................................................................................................................5  
          2.1.2. Notes ....................................................................................................................................5  
          2.1.3. Warnings ..............................................................................................................................5  
          2.1.4. Procedures ..........................................................................................................................5  
          2.2. TERMINOLOGY .......................................................................................................................6  
TOTAL RECALL ....................................................................................................................................7  
3.    OVERVIEW OF TOTAL RECALL .....................................................................................................7  
   3.1. WHAT IS TOTAL RECALL? ..........................................................................................................7  
   3.2. STANDARD FEATURES ..............................................................................................................7  
   3.3. OPTIONAL FEATURES ................................................................................................................7  
4.    GETTING TO KNOW TOTAL RECALL ............................................................................................8  
   4.1. UNIT LAYOUT – FRONT ..............................................................................................................8  
          4.1.1. Headphone Jack ....................................................................................................................9  
          4.1.2. Line Output Jack ..................................................................................................................9  
          4.1.3. Volume Control Thumb Wheel ............................................................................................9  
          4.1.4. DVD/CD or optional BD Writer ..........................................................................................9  
          4.1.5. Speaker Grill ........................................................................................................................9  
          4.1.6. Cooling Fan Vent .................................................................................................................9  
          4.1.7. Front Panel On/Off Switch ....................................................................................................9  
   4.2. REAR PANEL .............................................................................................................................10  
          4.2.1. Remote Connection Ports ....................................................................................................10  
          4.2.2. Line Interface Connectors ..................................................................................................10  
          4.2.3. Power Cable Socket ..........................................................................................................11  
          4.2.4. Power Supply (Standard: Desktop & Rack) .......................................................................11  
          4.2.5. Power Supply (Optional Hot-Swap: Rack only) .................................................................11  
5.    TOTAL RECALL – ONBOARD CONTROLS ..................................................................................12  
   5.1. CONTROL PANEL .....................................................................................................................12  
          5.1.1. Playback and Navigation Keys ............................................................................................12  
          5.1.2. Power and Hard Drive Activity LEDs ...............................................................................13  
6.    MAIN SCREENS ............................................................................................................................13  
   6.1. MENU SITE MAP ......................................................................................................................14  
   6.2. THE OPTIONS MENU ..............................................................................................................15  
   6.3. THE LOGGING SCREEN ..........................................................................................................15  
          6.3.1. Columns ..............................................................................................................................16  
          6.3.2. Live Monitoring ................................................................................................................17  
   6.4. THE SEARCH MENU ..............................................................................................................18  
          6.4.1. Searching ...........................................................................................................................18  
          6.4.2. Using Search Criteria ......................................................................................................20  
          6.4.3. Call Playback ....................................................................................................................22  
          6.4.4. Tagging .............................................................................................................................23  
          6.4.5. Recent Calls (Automatic Recent Call Display) ...............................................................23  
          6.4.6. Archiving ...........................................................................................................................24  
          6.4.7. Performing a Manual Archive ..........................................................................................25
6.4.8. Deleting Calls .........................................................................................................................27
REMOTE MANAGER ............................................................................................................................28
7. OVERVIEW ......................................................................................................................................28
8. INSTALLATION AND INITIAL CONFIGURATION ........................................................................28
9. USER INTERFACE ............................................................................................................................28
10. MAIN MENU BAR ..........................................................................................................................29
10.1. FILE MENU ..................................................................................................................................29
10.2. HELP MENU ..................................................................................................................................30
11. BUTTON BAR ..................................................................................................................................31
11.1. CHANGING YOUR PASSWORD OR DISPLAY LANGUAGE ..........................................................31
12. TR TREE ...........................................................................................................................................32
13. MONITOR TAB ...............................................................................................................................33
13.1. MONITORING CALLS BY CHANNEL .....................................................................................34
13.2. MONITORING CALLS BY EXTENSION ..................................................................................35
   13.2.1. Filtering the Call List ............................................................................................................36
13.3. ADDING NOTES ...........................................................................................................................37
14. PLAYBACK CALLS TAB ...................................................................................................................37
14.1. THE DEVICE TREE ..................................................................................................................38
   14.1.1. DVD/CD Drives ....................................................................................................................38
   14.1.2. Local Folders .......................................................................................................................39
   14.1.3. Network Shares (Optional on TR Rack only) ..................................................................40
   14.1.4. Total Recall Systems ............................................................................................................41
14.2. SEARCHING FOR CALLS .........................................................................................................42
   14.2.1. Using Search Criteria ...........................................................................................................42
14.3. PLAYING CALLS ..........................................................................................................................44
14.4. SAVING RECORDINGS ..............................................................................................................45
   14.4.1. Saving Single Calls from the Call List ..................................................................................45
   14.4.2. Saving Multiple Calls to Local Folders ...............................................................................45
14.5. EMAILING RECORDINGS .........................................................................................................45
14.6. DELETING RECORDINGS ..........................................................................................................46
14.7. NOTES .........................................................................................................................................46
14.8. CUSTOMISING THE CALL LIST ...............................................................................................46
14.9. SYSTEM MAINTENANCE OPTIONS .........................................................................................47
   14.9.1. System Information ...............................................................................................................48
   14.9.2. Archive .................................................................................................................................48
   14.9.3. Rebuild TR Database ............................................................................................................49
   14.9.4. Update TR Software .............................................................................................................49
   14.9.5. Load TR Settings ..................................................................................................................50
   14.9.6. Save TR Settings ..................................................................................................................50
   14.9.7. Shutdown ..............................................................................................................................51
15. EVENT LOG TAB ............................................................................................................................51
15.1. EVENT TYPES ............................................................................................................................51
15.2. USING THE EVENT LOG ..........................................................................................................51
RECORD ON DEMAND ..........................................................................................................................53
16. OVERVIEW ......................................................................................................................................53
16.1. INSTALLATION AND INITIAL CONFIGURATION ....................................................................53
17. USING ROD ......................................................................................................................................54
17.1. LOGGING IN ...............................................................................................................................54
17.2. RECORDING ..............................................................................................................................54
17.3. LOGOUT AND REFRESH ...........................................................................................................54
17.4. ADDING NOTES ...........................................................................................................................54
17.5. CONFIGURATION .........................................................................................................................55

GLOSSARY ..................................................................................................................................................56
SPECIFICATIONS .....................................................................................................................................59
LIMITED PRODUCTS WARRANTY ........................................................................................................60

18. COMSECTR LIMITED PRODUCTS WARRANTY ..............................................................60
18.1. OUR STANDARD LIMITED WARRANTY PERIOD .................................................................60
18.2. EXCEPTION FOR SALES ARISING FROM STOCK-CARRYING DISTRIBUTORS/DEALERS ....60
18.3. LIMITATIONS OF THIS WARRANTY ......................................................................................60
18.4. HANDLING OF FAULTY PARTS ..............................................................................................60
18.5. COMSECTR RECORD KEEPING ............................................................................................61

19. WARRANTY CLAIMS AND PROCEDURE ...........................................................................61
19.1. WHO TO CONTACT .....................................................................................................................61
19.2. WHAT PROCEDURE WILL BE FOLLOWED? .............................................................................61
19.3. WHAT SERVICES WILL BE PERFORMED? .............................................................................61
19.4. IMPORTANT NOTICE: SOLE & EXCLUSIVE REMEDY ......................................................62
19.5. DISCLAIMER OF WARRANTIES ...............................................................................................62
19.5.1. Important Notice: Disclaimer of Warranties .......................................................................62

LEGAL ..........................................................................................................................................................63

20. COMSECTR SOFTWARE LICENCE ......................................................................................63
21. GNU PUBLIC LICENSE .............................................................................................................65
About This Manual

1. Introduction

This User Guide is intended for Total Recall end-users who will be using the system to record and play back recorded data.

See the Total Recall Installation and Administration Guide for information about installation and system configuration.

We recommend that you keep a copy of this user guide handy for quick reference.

2. Conventions and Terminology

2.1. Conventions

2.1.1. References

References to other manuals or other parts of this manual are indented, formatted in blue text, and marked with a hand symbol:

Reference example

2.1.2. Notes

Notes are indented, formatted in blue text with light gray borders, and marked with a note symbol:

Note example

2.1.3. Warnings

Warnings are indented, formatted in blue text with light gray borders, and marked with a warning symbol:

Warning example

2.1.4. Procedures

Procedural lists describing tasks are marked with a ‘cogs’ icon, and the purpose of the procedure is formatted in bold italic text:

Procedure Start Example:

1. Procedure step example
2.2. Terminology

The following table lists some writing style conventions used in this manual and their associated meanings.

<table>
<thead>
<tr>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘Select <strong>OK</strong> to save your settings’</td>
<td>Highlight (position the cursor over) the <strong>OK</strong> screen button, and press the [Select] key on the control panel</td>
</tr>
<tr>
<td>‘Select a date from the list…’</td>
<td>Highlight the relevant data field, and press the [Select] key repeatedly to cycle through the available options, until you reach the required value</td>
</tr>
<tr>
<td>‘Check the <strong>Recording Period</strong> check box’</td>
<td>Highlight the relevant check box, and press the [Select] key to populate it with a check mark</td>
</tr>
<tr>
<td>‘Enter the <strong>IP address</strong>…’</td>
<td>Highlight the relevant data field, and enter the <strong>IP address</strong> using the numeric keypad on the control panel</td>
</tr>
</tbody>
</table>
## 3. Overview of Total Recall

### 3.1. What is Total Recall?

*Total Recall* is a compact, cost-effective and self-contained digital voice logger and recorder that records and provides secure storage for up to 350,000 individual records or 60,000 hours of calls and/or other audio signals.

*Total Recall* is easily operated via a simple control panel and intuitive menu system, or remotely via a network using the *Remote Manager* Client software - included with unlimited licenses as part of your solution.

*Record on Demand* software (also supplied) may be installed onto users’ PCs to allow limited control over what is recorded on their channel.

Depending on network type and configuration, *Total Recall* can also record the telephone numbers of incoming and outgoing calls, the time and date of the call, the duration of the call, and reference to a specific channel number. All of this information can be used to search and retrieve calls from the internal database or archived call data.

### 3.2. Standard Features

- Compact, self-contained, easy to install and operate.
- Record analogue telephone conversations.
- Record other analogue audio signals, such as two-way or broadcast radio.
- Onboard storage for up to 350,000 records/60,000 hours of calls.
- Archive recordings to DVD+RW, CD-R and/or CD-RW.
- Secure and tamper proof recording format.
- Export to MP3, WAV or secure TRC format.
- Policy based recording control.
- One-click real-time monitoring of calls.
- Email and copy calls directly from *Remote Manager* on your Windows 2000/ME/XP/Vista 32/Vista 64 PC. Supplied free-of-charge and license free.
- Powerful search capability.
- Feature-rich call player.
- All remote access, monitoring and management software included.

### 3.3. Optional Features

- Blu-Ray (BD-RE) Archive Device (optional on both Desktop and Rack models).
- Dual Hot-Swap Power Supplies (optional on *Total Recall Rack* model only).
• Channel Upgrades: **Total Recall Desktop** can accommodate two Digital Signal Processor (DSP) cards, and **Total Recall Rack** can accommodate four DSP cards. Systems may be upgraded with 4, 8 or 12 channel cards.

• Software Upgrades (optional on **Total Recall Rack** model only)
  - TCP/IP Network Call Archiving.
  - Simple Network Messaging Protocol (SNMP) Alarm Interface Support.
  - Station Messaging Detail Record (SMDR) Support.

Contact your supplier for more information on obtaining upgrades for your **Total Recall** system, or see [www.totalrecallvr.com](http://www.totalrecallvr.com)

### 4. Getting to Know Total Recall

**Total Recall** is simple to operate, is fully self-contained and can be operated using the built-in controls and display panel.

It is not necessary to attach a PC and monitor as a management console for the recorder. However, you may configure and operate your **Total Recall** via a networked PC and the included **Remote Manager** software if you wish.

See **Total Recall Remote Manager** on page 28 for more information on using & configuring your **Total Recall** via a network or dialup connection.

### 4.1. Unit Layout – Front
4.1.1. **Headphone Jack**

This is a standard 3.5mm three conductor stereo audio jack for connection of headphones or external speaker, volume controlled via the thumb wheel.

4.1.2. **Line Output Jack**

This is a standard 3.5mm three conductor stereo audio jack for connection to a tape recorder or the line input of a PC. This output is not volume controlled.

4.1.3. **Volume Control Thumb Wheel**

A thumb wheel to adjust internal speaker volume.

4.1.4. **DVD/CD or optional BD Writer**

A standard DVD/CD or optional BD read/write unit with standard DVD player/recorder controls.

4.1.5. **Speaker Grill**

This is a grill that is located on the left side of the unit. It protects the in-built speaker.

4.1.6. **Cooling Fan Vent**

This is an opening that is located at the base of the unit (Desktop unit), or the top left-hand corner of the front panel (Rack unit). It is protected by a grill, and acts as an air intake for the unit. The grill is removable to allow access to the filter media for cleaning or replacement.

4.1.7. **Front Panel On/Off Switch**

The Key Switch is located on the left side of the front panel for both Desktop and Rack units.
This is used to restart the unit after a Software Upgrade. For example, when the unit is mounted in a 19" rack the On/Off Switch that is located at the rear of the unit on the Power Supply may not be accessible.

It is recommended that the On/Off Switch Key is not left in the switch to prevent accidental powering off the unit.

4.2. Rear Panel

4.2.1. Remote Connection Ports

One standard RJ45 port (8P8C) is available for TCP/IP network connection.

The Modem (RS232) port is a standard male DB9 socket.

4.2.2. Line Interface Connectors

**Total Recall** has 4, 8, 12, 16, 20, or 24 channel inputs for the **Desktop** Unit, and 4, 8, 12, 16, 20, 24, 28, 32, 36, 40, 44 or 48 channel inputs for the **Rack**
Unit. The connectors for the telephone line interface are standard RJ11C/RJ12/RJ14 (6P4C plug).

4.2.3. **Power Cable Socket**

IEC 90-260 VAC power cable socket.

4.2.4. **Power Supply (Standard: Desktop & Rack)**

*Total Recall Rack* and *Desktop* are supplied as standard with a Mini-ATX auto sensing power supply, 100-240 VAC, 50-60Hz, 180 watts maximum.

4.2.5. **Power Supply (Optional Hot-Swap: Rack only)**

*Total Recall Rack* is available with an optional **Dual Hot Swap** power supply auto-sensing 100-240 VAC, 50-60Hz, 400 watts total.

To remove a hot-swap power supply module, simultaneously push the two black tabs inwards and pull the flip-up handle. A power supply module can be removed while the unit is powered up and running, assuming the other module is operational. Removing a power supply module will cause an alarm to sound until it is replaced.

To replace a hot-swap power supply module, remove the faulty module according to the above instructions, and slide a new module into the vacant opening, pushing firmly until the module locks into place.
5. Total Recall – Onboard Controls

Total Recall is simple to operate, and features a built-in control and LCD display panel for convenient configuration and operation.

5.1. Control Panel

The color TFT LCD displays the various screens, menus and dialogs. After five minutes of keypad inactivity, the LCD backlight automatically switches off, to extend the life of the backlight (the recorder continues to function normally).

Pressing any key illuminates the LCD backlight.

5.1.1. Playback and Navigation Keys

The playback and navigation keys are used to control the playback of recorded calls, and to navigate the screen menus.

[Menu] Key

The [Menu] key is used to navigate between the three main menus, Logging, Search, and Options. When [Menu] is pressed with the cursor at the top of one
of the three main menus, the cursor moves to the top of the next main menu. The system will “beep” each time the [Menu] key is pressed.

When [Menu] is pressed and the cursor is in the body of a main menu, the cursor will go straight to either the OK or Cancel button saving keystrokes.

**[Select] Key**

Use the [Select] key to start an operation associated with a highlighted button or item, and to confirm a request.

**[Up] and [Down] Scroll Keys**

The [Up] and [Down] arrow keys are used to navigate within a menu. With each [Up] or [Down] key press, the cursor highlights a different button or item within the menu. As you press the [Up] or [Down] arrow keys, the system will “beep”.

Use the [Down] key to highlight items across the screen from left to right as well as down. Use the [Up] arrow key to move in the reverse direction.

**Call Playback Keys**

During the playing of a call, the “Control Keys” can be used to navigate through the call. The “Control Keys” operate in the same way as the keys on a CD or tape player. They can be used to Stop, Play, Fast Forward and Fast Rewind through a call. Pressing the “Play” key during playback will cause the playback to Pause. Pressing the “Play” key again will continue the call.

Pressing the “Stop” key whilst not playing a call locks the User Interface (the padlock icon on the LCD ‘closes’) when in the **Options, Logging** and **Search** Menus. This negates the normal 120-second timeout required for the User Interface to lock.

5.1.2. Power and Hard Drive Activity LEDs

- Green is the ‘Power On’ indicator.
- Red indicates hard drive activity.

If the LCD backlight has switched off due to inactivity, the green LED flashes continuously every two seconds. Pressing any key illuminates the LCD backlight and the green LED stops flashing.

Your Total Recall system will continue to record normally while the LCD is turned off.

6. Main Screens

There are 3 main screens in the **Total Recall** GUI:

- The Options Menu (**Administrators Only**).
• The Logging Screen.
• The Search Screen.

Listed below are the user selectable/definable options on the Total Recall system, and their default values. Default values are listed in **bold**.

The Menu Site Map below only refers to system functions available via the user password. For the full menu site map, see the Total Recall Installation and Administration Guide.

### 6.1. Menu Site Map

#### Logging Menu

**Search Menu**

*Recent Calls (On/Off)*

*Search*

Date
Time
Number
Extension
Tag

- Tagged Only
- Untagged Only

Direction

- Incoming
- Outgoing
- Internal
- Unknown

Channel

**Search Archive**

**Search DVD/CD**

Search Network Archive (*Will only appear if optioned on TR Rack*)

*Tag All*

*Untag All*

**Archive**

*All Calls*

- Found Calls
- Unarchived Calls
- Tagged Calls

*Archive Device*

**CD/DVD**

Network Share (*Will only appear if optioned on TR Rack*)
6.2. The Options Menu

![Image of the Options Menu](image_url)

*Figure 1 - The Options Menu (TR Rack Menu Shown)*

The Options Menu allows access to various system configuration screens, plus the maintenance menu and system shutdown function.

Options that are not available on your recorder will be grayed out and cannot be selected.

Most options are set during installation by a system administrator, and following the initial installation, can generally be left alone – unless there are changes to recording requirements, the user base, or the network.

The Options Menu is only available to users with administrator privileges.

See the [Total Recall Installation and Administration Guide](#) for information on using the Options Menu.

6.3. The Logging Screen

![Image of the Logging Screen](image_url)

*Figure 2 - The Logging Screen*

The Logging screen is used to monitor calls that are currently in progress, and displays the calls that are currently being recorded, sorted by start date and time, with the most recent call at the top.
To play back calls that have already been completed, use the Search Screen. See page 18 for further information.

The call number, plus the number of active calls, and the total number of calls (active calls plus calls in the database) is shown in the bottom left corner of the screen (in the format x/y/z – where x is the call number, y is the number of active calls, and z is the total number of calls).

The percentage used (the percentage of the hard disk that is currently taken up by calls) is shown in the bottom right corner of the screen.

**Total Recall** has a maximum internal capacity of 60,000 hours (100% disk space) or 350,000 records, whichever is reached first. **Total Recall** will automatically delete the oldest 50,000 calls when capacity is being approached to maintain sufficient space for new recordings.

Use the ▲ and ▼ keys to scroll through the call list in the Logging Screen.

### 6.3.1. Columns

The Logging Screen includes columns for:

**Date**: The date when the call started.

**Time**: The time when the call started.

**Length**: The current length of the call.

**From**: The originator of the call.

**To**: The recipient of the call.

Note that the value in the **From** and **To** fields may be:

- Empty (if there is no ‘calling number’ signaling on the line).
- The ‘raw’ calling number, taken directly from the call signaling, if present on the line.
- A ‘mapped’ value (alpha and/or numeric), if the calling number has been mapped to another value in the Signaling Mapping for the recorder.

See the **Total Recall Installation and Administration Guide** for further information about Signaling Mapping.

**Channel** (Ch.): A call direction indicator, plus the channel number upon which the recording is being made.

Call direction indicators are as follows:

- < indicates an incoming call
- > indicates an outgoing call
- ^ indicates an internal call
- ? indicates that the call direction could not be established
Extensions may be configured during installation by the system administrator, via the Analog Settings menu on the unit, or via Remote Manager. ‘Extensions’ are text or numeric values that are assigned to channels, which can be used for searching calls, or to use Record-on-Demand (see page 53). Please note that text-based extension values cannot be searched via the onboard control panel.

See the Total Recall Installation and Administration Guide for information about how extensions are configured.

Marks (C / M)
- C indicates a current call.
- M indicates a call that is being currently monitored.

6.3.2. Live Monitoring

Live monitoring can be used to ‘listen in’ on current, active calls.

- It is only possible to monitor calls if Monitoring has been enabled for that extension by an administrator.

To monitor a channel, highlight a current call in the Logging Menu by pressing the [Down] and [Up] arrow keys, then press [Select].

The audio on that channel is played through the loudspeaker or headphones.

The letter M is displayed in the Status column and the call is moved to the top of the call list.

To end monitoring, press [Select] again (This does not terminate the call).

Monitoring of a selected channel will continue until manually terminated, even if there is no current audio on the channel.

The Total Recall unit will remain unlocked until you manually terminate live monitoring.
For analog channels connected to phone lines, if ‘Beep’ is active for the channel that is being monitored, both parties hear a beep at regular intervals to indicate that the call is being monitored. Beep settings can only be edited by a user with administrator privileges.

6.4. The Search Menu

Use the Search Screen to locate calls according to a range of search criteria (date, time, channel, telephone number etc.) and to play back calls returned by the search.

6.4.1. Searching

To search for calls on the internal hard drive:

1. Press the [Down] arrow key to highlight the Search button. Press [Select] to open the Search Options dialog:

![Search Options Dialog]

2. Use the [Down] arrow to highlight check boxes for the available search criteria. Press [Select] to activate the highlighted criteria, and then configure your search parameters using the [Down] and [Select] keys.
3. When you have finished specifying your search criteria, use the arrow keys to highlight Search and press [Select].
   An information window displays, summarizing the search results. The results are listed in the Search Screen.
   
   If more than 1000 results are returned, only the 1000 most recent calls are listed on the Search Screen. If you wish to see calls older than those that are initially listed, press the Rewind [] key while playback is not in progress to display the next oldest 1000 calls. Press Fast Forward [] to return to the more recent listings if required.

To search for calls on a DVD/CD/BD:

1. Insert the DVD, CD or (optional) BD that you wish to search into the Total Recall DVD/CD/BD drive. If you wish to search an archive on network storage (optional on Total Recall Rack only), continue to step 2.

   Your Total Recall can search and replay archive DVD/CDs created by other Total Recall units, or even archive DVD/CDs from old generation Total Recall systems.

2. Arrow down to highlight Search, and press [Select].
   The Search Options dialog displays:

   ![Search Options Dialog]

3. Use the [Down] arrow to highlight check boxes for the available search criteria. Press [Select] to activate the highlighted criteria, and then configure your search parameters using the [Down] arrow and [Select] keys.

4. When you have finished specifying your search criteria, arrow down and highlight Search Archive. Press [Select] to confirm that you wish to search an archive drive.
   The Archive Selection dialog appears.
5. The Archive Device to be searched will be the DVD/CD drive by default. If you wish to search a DVD/CD, arrow down to the OK button and press [Select].

An information window displays, summarizing the search results. The results are listed in the Search Screen.

To search for calls on a Network Share (Optional on TR Rack only):

1. Follow steps 2 to 5 as above.

The Archive Selection dialog appears.

2. Set the Archive Device to Network Share by pressing the [Select] key while the archive device field is highlighted.

The Type, Path, User and Password parameters for the network share must be pre-configured via Remote Manager.

See the Total Recall Installation and Administration Guide for information on configuring Network Shares.

3. Select the required Archive.

There may be more than one archive on the network share. Each archive can contain up to 250,000 recordings. The name of the archive is the date when it was created in the following format: yyyyymmddhhmm, that is a 4 digit year, followed by two digit month, day of month, hour of day and minute.

4. Select the OK button.

An information window displays, summarizing the search results. The results are listed in the Search Screen.

6.4.2. Using Search Criteria

Various types of information (listed below) can be used as search criteria.
To search by each criteria type, select the appropriate check box in the **Add Calls to List** dialog, and enter or select the required value/s in the associated data field/s.

- **Date**
  Required data: **Date From** and **Date To**.

- **Time**
  Required data: **Time From** and **Time To**.

  Time criteria can not span 00:00 (midnight). To search a time period that spans midnight, either search using date criteria only, or initially search up to 23:59 hours on Day 1, and then search from 00:00 hours on Day 2.

- **Number**
  Required data: numeric.

  The Number search returns any results *containing* the search string.

  For example, with search criteria *2001* in the Number field, the search will return any calls to or from telephone number 2001, and also to or from numbers 20015, 32001, 620014, etc.

- **Extension**
  Required data: numeric.

  The Extension search only returns results that match the search string *exactly*.

  For example, with search criteria *2001* in the Extension field, the search will return calls to or from extension 2001, and no other calls.

- **Tag**
  Available options: Tagged Only | Untagged Only | Tagged & Untagged.
  The data field defaults to **Tagged & Untagged** (all calls).

  See section 6.4.4. of this manual for a description of the ‘Tagging’ function.

- **Direction**
  Available options: Incoming | Outgoing | Internal | Unknown.

  The data field defaults to **Incoming**.

  ‘Unknown’ refers to calls that **Total Recall** is unable to resolve an origin and/or a destination for.

- **Channel**
  Required data: numeric.
Performing a search with no search criteria entered will return all calls on the database or archive.

**Multiple Criteria**

Search criteria are cumulative – only calls that match all specified criteria are returned. The more criteria entered, the more specific the result.

For example, to search for tagged calls made between 6am and 11am from extension 2001, use the following search criteria:

- Time: 06:00 to 11:00.
- Tag: Tagged Only.

### 6.4.3. Call Playback

Following a search, the results are listed in the Search Screen, sorted by date and time, with the most recent call at the top.

To play a call, highlight it and press [Select], or press the ▶ key on your control panel.

Press ▶ again to pause playback.

Press ▶▶ to fast-forward.

Press ▶▶▶ to skip forward.

Press ◀◀ to rewind.

Press □ to stop playback.

Use the thumb wheel on the front panel to adjust the playback volume.

Progress through the call is displayed as a progress bar at the bottom of the LCD display.
6.4.4. Tagging

Tagging calls is a way to mark them so that they can be selectively searched or archived using the Manual Archive function. To tag a call for manual archiving:

- Highlight the call in the Search or Logging Screen, and press * on your control panel.

To untag a tagged call:

- Highlight the tagged call and press * again on your control panel.

To tag all calls in the list on the Search Menu:

- After completing a search, highlight the Tag All button on the Search Screen and press [Select].

To untag all calls in the list on the Search Menu:

- After completing a search, highlight the Untag All button on the Search Screen and press [Select].

You cannot tag search results from an archive.

6.4.5. Recent Calls (Automatic Recent Call Display)

To display the most recent completed calls on the Total Recall database, highlight the Recent Calls button and press [Select]. The most recent calls will display in the search screen, and will be automatically refreshed according to your configuration in the Options Menu > General Settings > Recent Calls menu. The Recent Calls button will flash to indicate that it is active:

See the Total Recall Installation and Administration Guide for information on configuring Recent Calls.

Recent calls will continue to be automatically refreshed until a key is pressed on the system; for example if you change menus by pressing the [Menu] key, or press the [Down] arrow key to replay a call.

To restart automatic recent call refresh, re-highlight the Recent Calls button using the [Up] and [Down] arrow keys as required, then press [Select].
**To Replay the Most Recent Completed Call:**

1. Press the [Menu] key to enter the Search Menu (if required).

2. Activate Recent Call Refresh by highlighting the ‘Recent Calls’ button (if required) with the [Down] arrow key, and press [Select].

3. The **Recent Calls** button will flash to indicate that it is active, and the most recently completed calls on Total Recall’s database will appear, and will be automatically refreshed according to your configuration in the Options > General Settings > Recent Calls menu.

4. The first call on the screen is the most recent competed call on the database, and this is highlighted by default in **Recent Calls** mode. If the call you wish to replay is further down the list, continue pressing the [Down] arrow key until your target call is highlighted. Please note that pressing the [Down] arrow key will deactivate **Recent Calls** mode, and the icon will stop flashing accordingly.

5. Press [Select] to replay the highlighted call.

6. To re-activate **Recent Calls** mode after replaying a call, navigate back to the Recent Calls button with the [Up] or [Down] arrow keys, and press [Select].

### 6.4.6. Archiving

**Introduction**

**Total Recall** stores call files internally on the hard disk drive. Call files can be archived to DVD, CD, or optionally to a Blu-Ray device (**Desktop and Rack**), or to network shared storage (**Rack** only). Archiving may be performed manually, or automatically, at scheduled intervals.

See the [**Total Recall Installation and Administration Guide**](#) for further information on Automatic Archiving.

Approximately 1,000 channel hours can be archived to a standard DVD and approximately 180 channel hours to a standard CD, depending on the call lengths and the number of sessions used.

The number of channel hours that can be stored on any given Network Share depends on the storage space of the network device. A standard single layer BD-RE disc can store approximately 6,000 hours of calls.

To ensure the security of your call data, it is recommended that calls are archived on a regular basis. Call recording continues during the archive process. Progress is displayed on the screen. Other recorder functions (except recording) are disabled during the archive process.

The CD/DVD drawer will open and close during the archive process. Remove any potential obstructions to the CD/DVD drawer opening and closing.

Archiving on DVD/CD/BD is performed in sessions. Each session updates the disk directory, writes the calls, and closes the archive with an ‘end of session marker’. Therefore, archiving to disc media should be done thoughtfully, as each session marker uses approximately 10 MB of disc space. This is
equivalent to approximately three hours of calls. Therefore, to minimize wasted space, it is advisable to archive as many calls as possible each time you archive, rather than archiving smaller numbers of calls more often.

To maintain compatibility with various CD readers, a maximum of 25 sessions is permissible per CD.

**Network Shares (optional on Total Recall Rack)**

**Total Recall Rack** has an in-built NFS Client and SAMBA Client to access NFS and Windows Network Shares.

Each Network Share can contain more than one archive, each with up to 250,000 records. The name of each archive is the date and time when it was created in the following format: yyyymmddhhmm (that is a 4 digit year, followed by two digit month, day of month, hour of day and minute).

### 6.4.7. Performing a Manual Archive

#### To archive manually to DVD/CD/BD:

1. Cycle to the Search Menu by pressing [Select].

2. Select calls to archive by performing a search and/or tagging the relevant calls (see section 6.4.1. to 6.4.4. of this manual) if required (see point 5 below).

3. Insert the DVD, CD or (optional) BD media into the Total Recall DVD/CD/BD drive.

4. Arrow down and highlight the Archive button. Press [Select].

The Archive Calls dialog displays.

<table>
<thead>
<tr>
<th>Archive Calls:</th>
<th>Found Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Calls:</td>
<td>16</td>
</tr>
<tr>
<td>Call Size (MB):</td>
<td>31,128 MB</td>
</tr>
<tr>
<td>Archive Device:</td>
<td>DVD/CD</td>
</tr>
<tr>
<td>Type:</td>
<td>NFS</td>
</tr>
<tr>
<td>Path:</td>
<td>192.168.3.196:/var/archiver/ont</td>
</tr>
<tr>
<td>User:</td>
<td></td>
</tr>
<tr>
<td>Password:</td>
<td></td>
</tr>
</tbody>
</table>

5. In the Archive Calls field, scroll through the available archive options by pressing the [Select] key. The following 4 options will be available:

- **All Calls** (all calls currently on the hard disk).
- **Found Calls** (all calls that are currently listed in the Search Screen).
- **Unarchived Calls** (all calls that have not been archived in the past).
- **Tagged Calls** (all tagged calls on the hard disk).

As archive options are selected, Total Recall displays the number of calls and the collective size of the calls (in MB).
6. Press the [Down] arrow key to select the appropriate Archive Device. For DVD/CD or (optional) BD archiving, select DVD/CD. If you have optional Network Archiving on your Total Recall Rack, press the [Select] key in the archive device field to select Network Share as the archive device.

7. Arrow down and highlight OK. Press [Select] to begin archiving.

If you have administrator privileges, a confirmation dialog displays asking if you would like to remove the calls that are archived from the hard disk. Select Yes to remove archived calls from the hard disk, or No to leave them in place.

The archive process begins.

A progress dialog displays while archiving is taking place. When archiving is complete, a message displays indicating that the process has finished.

If there is insufficient space on the DVD, CD or BD to complete the archive, Total Recall will archive as much as it can, and then prompt you to insert a new disc to complete the archive.

If the DVD, CD or BD is damaged and the archive fails, a message displays prompting you to insert another disc.

If there are problems with access to the Network Share, a message displays with information on the problem. If this is the case, the archive process fails until the problems are corrected.

**Automatic Archiving**

Automatic Archiving is configured via the Options Menu by a user with administrator privileges.

With Auto Archive active, Total Recall archives all unarchived calls on the hard disk at the frequency specified in the Archive settings.

The Auto Archive function archives all calls that have not been archived to a DVD/CD/BD or a Network Share. Calls that have previously been manually archived will not be included in the Auto Archive.

Total Recall can also be configured by administrators to display a message reminding the user to manually archive when the hard disk reaches a specified percentage of capacity.

If your Total Recall system is unlocked, AND a menu other than the main Logging, Search or Options screens is open at the scheduled auto-archive time, the Total Recall system will assume that you are currently using the unit. Auto-Archive will be delayed until you navigate back to one of the main screens.
6.4.8. Deleting Calls

Administrators may choose to delete calls from the hard disk during manual archiving.

Also, calls are automatically deleted when:

- A set period of time has passed since they were recorded (for example, 3 months). This option (Max. Call Lifetime) can only be activated by a user with administrator privileges.

- The number of calls on the hard disk reaches 350,000, or 60,000 recording hours. When this happens, the oldest 50,000 calls are automatically deleted, until the number of calls on the hard drive is reduced to 300,000.

Auto-deletion occurs according to the 3 conditions above, in the priority that they are listed. To avoid losing unarchived calls as a result of automatic deletion, it is important to be aware of recorder capacity and to ensure important calls are archived or saved regularly.
Remote Manager

7. Overview

Remote Manager is Microsoft Windows® compatible software that allows remote access from a PC to one or more Total Recall units, via LAN or dialup. Remote Manager is supplied on CD free-of-charge with all Total Recall systems, for installation and use on as many PCs as required.

Remote Manager can be used to:

- Configure the recorder (Administrator Users Only).
- Play recorded calls from the system or archive media – including archive media from older generation Total Recall systems.
- Monitor current calls in real-time.
- Search the call database.
- Archive recorded calls to CD/DVD or optional BD/Network storage.
- Tag and notate calls on the database.
- Download calls to the local hard drive.
- Email downloaded calls.
- Play and save calls from Total Recall archive discs.
- Generate reports.
- Export calls to .wav, .mp3 or secure .trc formats.

8. Installation and Initial Configuration

Remote Manager should only be installed and configured by a system administrator.

☞ See the Total Recall Installation and Administration Guide for further information.

9. User Interface

Remote Manager is a ‘tabbed’ application, including a Main Menu bar, a Button bar, and 4 tabs:

- Monitor.
- Playback Calls.
- TR Configuration.
- Event Log.
Please note that you will only be able to see the tabs that have been authorized for your specific user account by the System Administrator.

Figure 6 - the Remote Manager User Interface

10. Main Menu Bar

The Remote Manager main menu bar includes 2 menus – the File menu and the Help menu.

10.1. File Menu

The File menu includes the following options:
• **Users**
  Opens the Users dialog (administrators only).

• **User Preferences**
  Opens the User Preferences dialog.

  See *Changing your Password or Display Language* on page 31 for more information on altering Users and User Preferences.

• **Save Call List as**
  Saves the call list displayed in the Playback Calls tab as a .txt or .csv file. The data included reflects the current call list column configuration.

• **Print Preview**
  Opens a print preview of the Call Report.
  The Call Report is a print-formatted version of the call list displayed in the Playback Calls tab. The data included reflects the current call list column configuration.

• **Print**
  Prints the Call Report via the standard Windows print dialog.

• **Advanced**
  Opens the Advanced Settings dialog.
  Use the Advanced Settings dialog to set the local IP address for the PC, and the Manager Base Port.

• **Exit**
  Closes Remote Manager.

### 10.2. Help Menu

The Help Menu provides access to:

• The **Total Recall** website ([www.totalrecallvr.com](http://www.totalrecallvr.com))

• **Total Recall** FAQs on the web

• ‘About’ information (including the Remote Manager version number)
## 11. Button Bar

The button bar provides access to most of the Remote Manager administrative dialogs and functions.

The table below lists the buttons and their uses.

<table>
<thead>
<tr>
<th>Button</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Preferences</td>
<td>Opens the User Preferences dialog. Use the User Preferences dialog to edit general user preferences and Total Recall connections* for the current user.</td>
</tr>
<tr>
<td>Add TR (administrator users only)</td>
<td>Opens the Add Total Recall dialog. Use the Add Total Recall dialog to ‘add’* Total Recall recorders to the Remote Manager settings for the current user.</td>
</tr>
<tr>
<td>Update Users (administrator users only)</td>
<td>Opens the Update Users dialog. Use the Update Users dialog to add and remove users*, and to modify user preferences for all users in the user list.</td>
</tr>
<tr>
<td>Refresh Views</td>
<td>Refreshes the Device Tree and the Local Folders pane to reflect the latest changes.</td>
</tr>
<tr>
<td>Change Language Settings</td>
<td>Opens the Choose Language Settings dialog. Use the Choose Language Settings Dialog to specify the Remote Manager UI display language.</td>
</tr>
</tbody>
</table>

* Administrator function

See the Total Recall Installation and Administration Guide for further information about administrative functionality available from the Button Bar.

### 11.1. Changing your Password or Display Language

To change your Remote Manager Password or display language:

- Click the User Preferences button:

Or:

- Select File > User Preferences.
The Modify User Preferences menu will display. Your User name, and your current access permissions are displayed as read-only fields for reference.

![Modify User Preferences](image)

**To change your Remote Manager display language:**

1. Click the drop-down arrow to the right of the **Language** field and select your preferred language.
2. Click **OK**.

**To change your password:**

1. Click **Change Password**.
2. Enter the new password in the **Password** field.
3. Re-enter the password in the **Confirm Password** field.
4. Click **OK**.

### 12. TR Tree

![TR Tree](image)

The **TR Tree** is an expandable/collapsible tree showing the connected **Total Recall** recorders for the current user.

Click on a recorder to select it. Functionality and information to the right of the **TR Tree** applies to the selected recorder.
To update the TR Tree to reflect changes made to recorder connections, click the Refresh Views button.

If Remote Manager cannot connect to a recorder, then it shows a cross on top of the icon next to the recorder name as shown on the subsequent screen capture.

13. Monitor Tab

Use the Monitor tab to monitor current calls, and to add notes to calls.

Monitoring is only possible on extensions for which monitoring has been enabled.

See the Total Recall Installation and Administration Guide for further information on enabling and disabling live monitoring.
There are 2 ways to select calls for monitoring – by channel, and by extension.

As analog signal sources are physically connected to individual channel inputs on the recorder, a particular source will always come into the recorder on the same channel. For example, if PSTN telephone extension 2002 is connected to channel 1 on the recorder, calls to and from extension 2002 will always be recorded on channel 1.

No additional configuration is required to monitor calls by channel.

It is also possible to monitor analog PSTN signals by extension, if the analog channels have been assigned extension values in the Analog Settings menu, or if DTMF/CLI (called/calling) number data is present in the signaling, and this number data has been configured on the Total Recall Internal Dial Plan.

Extensions must be configured by a Total Recall Administrator.

13.1. Monitoring Calls by Channel

The Live Monitor panel displays a range of icons to indicate the status of each channel on the selected recorder.

The icons are defined in the table below.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Channel Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>📞</td>
<td>Live call in progress.</td>
</tr>
<tr>
<td>⌛</td>
<td>Monitoring in progress.</td>
</tr>
<tr>
<td>📘</td>
<td>Channel is active, but there is no activity on it.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Monitoring is disabled - channel cannot be monitored.</td>
</tr>
<tr>
<td>🟣</td>
<td>Channel is unauthorized for the current user.</td>
</tr>
<tr>
<td>🔐</td>
<td>Monitoring is unavailable – insufficient network bandwidth</td>
</tr>
</tbody>
</table>

The panel is automatically updated as and when each channel’s status changes.
To monitor a call by channel:

1. In the TR Tree, click on the recorder containing the channel that you want to monitor.

2. In the black Live Monitor panel at the base of the monitoring screen, click the channel icon for the channel that you want to monitor. The call audio on that channel should now be heard on the headphones / speakers.

3. To stop monitoring, click the Stop Monitoring button.

13.2. Monitoring Calls by Extension

The Active Extensions panel displays a list of all current calls on the selected recorder that can be resolved to an extension. Extensions need to be configured by a Total Recall Administrator, via the Analog Settings menu, or via the Internal Dial Plan.

See the Total Recall Installation and Administration Guide for further information on configuring extensions.

The call list is updated dynamically when new calls start and current calls finish.

If a call comes in and cannot be immediately resolved to an extension, it will appear in the Live Monitor panel (see Section 13.1 above), and then also appear in the Active Extensions panel if and when the extension information becomes available.

The Active Extension panel includes columns for:
- From number.
- To number.
- Direction (incoming / outgoing).
- Agent Name (if a ROD agent is logged in on the called or calling extension).
- Channel.
- Extension.
To select calls for monitoring by extension:

1. In the TR Tree, select the recorder that contains the extension that you want to monitor.
   The call list in the white Active Extensions panel at the top of the monitoring tab is populated with all current calls that can be resolved to an extension.

2. In the Active Extensions panel, click on the call that you want to monitor.
   The call can be heard on the headphones/speakers.
   The channel on which the call is being recorded is highlighted in the Live Monitor panel.

3. To stop monitoring, click the Stop Monitoring button, or select another call.

13.2.1. Filtering the Call List

You can filter the call list to show only calls that either match exactly, or begin with, the entered values. This is especially useful for finding the right extension to monitor on installations with a large number of active extensions.

To filter the calls listed in the Active Extensions panel:

- Enter alphanumeric values in the Match extensions or Match numbers field.
  The call list is updated dynamically as values are entered.

For example, to filter the call list to show only calls to or from extension 2006, enter 2006 in the Match extension field.

To filter the call list to show only calls from all extensions in the range 2100-2199, enter 21 in the Match number field.

Calls from all extensions that begin with 21 will be shown – for example, if your dial plan supports 3 and 4-digit extensions, calls from extensions 210-219 and calls from extensions 2100-2199 will be shown.

To filter the call list to show only calls to or from extension John Smith, enter John Smith in the Match extension field.

To filter the call list to show only calls to or from number 0210 456 789, enter 0210 456 789 in the Match number field.

To filter the call list to show only calls to or from all numbers beginning 0210, enter 0210 in the Match number field.

This is a particularly useful function if you want to filter calls by area code.

To sort the call list:

- Click the relevant column header.
13.3. Adding Notes

Adding notes to calls is a useful way to record information about the call, such as an important request or the ID number of the client involved.

Notes can later be used as search criteria in the Playback Calls tab.

*To add a note to a call:*

1. Select the call in the Active Extensions panel, or an active channel in the Live Monitor panel.
2. Type the note in the Add Notes text field. The field supports up to 80 characters.
3. Click Add Note.

The note is added to the call.

14. Playback Calls Tab

Use the Playback Calls tab to search for and play recorded calls, from:

- Connected Total Recall recorders.
- Total Recall archives on DVD/CD (or optional BD). Calls from archive CDs from any Total Recall system may be replayed, copied to local folders or emailed, including those from superseded or old-generation units.
- Total Recall archives on a Network Share (optional on TR Rack only).
- Local Folders (configured folders on local or network hard drives).
14.1. The Device Tree

The **Device Tree** is an expandable/collapsible tree showing the currently available devices that may contain **Total Recall** call records to search. These may be:

1. The local DVD/CD drive on your PC (if configured).
2. Local Folders on your PC (if configured).
3. Network Shares (optional on **TR Rack** only, if configured).
4. Any connected **Total Recall** recorders.

Click on a device in the Device Tree to select it for searching. Functionality and information to the right of the **Device Tree** applies to the selected device only.

Click the ✉ icon for a device to reveal further information about the calls stored on that device, which can be either the dates of the archives, or the extensions involved.

To view the **Device Tree** sorted by date, select the **Sort by Date** tab at the base of the tree. Alternatively, to view the **Device Tree** sorted by extension, select the **Sort by extension** tab.

To update the **Device Tree** to reflect changes made to recorder connections, click the Refresh Views button:

### 14.1.1. DVD/CD Drives

Any DVD/CD Drives configured on your PC can be added to the **Device Tree**, where they can be selected for searching.
To add a DVD/CD drive:

1. In the Device Tree, right click on ‘DVD/CD Drives’.
2. Click Select Drive.

The Configure DVD/CD ROM dialog appears.

3. Select the DVD/CD Drive Letter of the DVD/CD drive on your local machine.
4. Click OK.

The drive will now appear in the Device Tree, and may be used to search archive discs from Total Recall.

14.1.2. Local Folders

Local Folders are specially configured folders on a local or network hard drive, into which calls can be saved (individually or in groups), which can later be searched from within Remote Manager.

Local Folders appear in the Device Tree, where they can be selected for searching, and where calls can be saved via drag and drop from another location.

To add local folders:

1. In the Device Tree, right click on ‘Local Folders’.
2. Click Add Folder.
3. Specify the file path by navigating to an existing folder or by creating a new folder. This can be a folder on your local drive, or on another (networked) machine.
4. Click Open.

The new local folder will now appear in the Device Tree.

To remove existing local folders:

1. In the device tree, expand the list of Local Folders.
2. Right click on the local folder that you want to remove.

3. Click **Remove Folder** in the drop down menu.

**To refresh local folders:**

- On the button bar, click the Refresh Views button.

Or:

- Right click on the Local Folder in the **Device Tree**, and click **Refresh Folder** in the drop down menu.

Refreshing local folders updates the device tree with any changes made to Local Folders outside of **Remote Manager**.

**14.1.3. Network Shares (Optional on TR Rack only)**

Network Shares are specifically configured folders on local or network locations. They are set up in order to allow for the automatic or manual archiving of calls from your **Total Recall Rack** recorder to network storage. Calls on a Network Share may be searched via **Remote Manager** or from your **Total Recall Rack** recorder.

Network Shares appear in the **Device Tree** where they can be selected for searching.

**To add network shares:**

1. Right click on ‘Network Shares’ in the device tree.

2. Click **Add Shares** in the dropdown menu.

3. Select the appropriate network share type and file path, as well as providing the username and password for the network share location (where applicable). Your system administrator will supply these details.

4. Click **OK** to confirm settings.

To minimize unnecessary use of your network bandwidth, network share location(s) are not automatically connected for immediate search and replay. To access archives on a network share location, you must first ‘attach’ the location manually.
**To attach/detach existing network shares:**

1. In the device tree, expand the list of ‘Network Shares’ to view currently installed Network Share locations.
2. Right click on the specific Network Share location that you wish to attach or detach.
3. Click **Attach Share** or **Detach Share** in the drop down menu.

An attached network share will remain attached and available for immediate searching while you remain in the ‘Playback Calls’ tab. Selecting another tab will cause the network share to automatically detach.

The network share device tree follows the structure of **Network Share Location > Unit ID > Date of Archive > Date of Calls/Extensions (setting dependant).**

**To remove a network share:**

1. In the device tree, expand the list of network shares to view currently installed Network Share locations.
2. Right click on the specific Network Share location that you wish to remove.
3. Click **Remove Share** in the dropdown menu.

### 14.1.4. Total Recall Systems

The **Device Tree** also shows the connected **Total Recall** recorders for the current user.

![Device Tree Diagram]

**Total Recall** recorders appear in the **Device Tree** where they can be selected for remote searching.
### 14.2. Searching for Calls

**To search for calls:**

1. In the Device Tree, select a DVD/CD/BD Drive, Local Folder, Network Share or a Total Recall recorder that you want to search.
2. Enter any appropriate search criteria (see below for more information).
3. Click Search Now.
   
   The matched calls (up to a maximum of 1000 calls) are displayed in the call list.
   
   If no search criteria are entered, all calls on the selected device/s are returned.
   
   - To see more results (if over 1000 calls are returned) click [ ].
   
   - To return to the first 1000 results, click Search Now again.

#### 14.2.1. Using Search Criteria

The following types of information can be used as search criteria:

- Date.
- Time.
- Extension.
- Phone Number.
- Call Length.
- Note Keyword.
- Call Direction.
- Local Folder.
- Agent Name.

Search criteria are cumulative – only calls that match all specified criteria are returned. The more criteria entered, the more specific the result.

**Date**

To search for calls that were recorded after a certain date, click the Date from button and select a date from the calendar.
To search for calls that were recorded before a certain date, click the **Date to** button and select a date from the calendar.

If you click on an archive sorted by date in the **Device Tree**, the **Date from** and **Date to** fields are automatically populated with the appropriate date value.

**Time**

To search for calls that fall within a certain time range, click either of the **Time from** or **Time to** buttons, and set a time range using the sliders.

To set a time interval that spans midnight, set the **to** value to be less than the **from** value. The **to** value is then considered to be that time the next day.

**Extension**

To search for calls by extension, select **Extension** and enter an extension value in the text field (alpha and/or numeric).

If an archive sorted by extension is selected in the **Device Tree**, the **Extension** checkbox is automatically selected, and the text field is populated with the appropriate extension value.

> Extension values must first be configured by an Administrator. See the **Total Recall Installation and Administration Guide** for further information on configuring extensions.

**Phone Number**

To search for calls by phone number, select **Phone Number** and enter a numeric value in the text field.

Calls to or from the entered number are returned.

**Call Length**

To search for calls by call length, select **Call Length** and click the associated button: 💬. Set the call length range using the sliders.

If the minimum value is not set, all calls shorter than the maximum setting are returned.

If the maximum value is not set, all calls longer than the minimum value are returned.

**Note Keyword**

To search for calls by a keyword within a previously added note, select **Note Keyword** and enter the keyword/s in the text field.

Calls matching all the specified keywords are returned.

> The **Note Keyword** function is case sensitive.
**Call Direction**

To search for calls by call direction, select **Call Direction** and choose an option from the drop-down list.

Options are to search by:

- In (incoming calls), i.e. a call coming from an outside number to an extension inside your company.
- Out (outgoing calls), i.e. calls originating from within your company to outside numbers.
- Internal (calls between internal extensions).
- Unknown (**Total Recall** cannot determine whether the call is coming into or going out of your company).

See **Total Recall Installation and Admin Guide > Internal Dial Plan** for more information on how to specify extensions as internal.

**Local Folder**

To search for calls by local folder, select **Local Folder** and click the folder from the **Device Tree** to auto-fill the system path. Alternatively you can copy/paste full system path for the local folder into the text field.

If a local folder is selected in the **Device Tree** at any time, the **Local Folder** checkbox is automatically selected, and the text field is populated with the appropriate system path.

**Agent Name**

To search for calls made by a **ROD** agent, check the **Agent Name** box, and then select the agent’s name from the drop down box.

### 14.3. Playing Calls

When a search is complete, the results are displayed in the **Call List**.

*To play a call from the call list:*

- Select the call in the **Call List**, and click ►

Or:

- Double-click the call in the call list.

  The call will then be played through the headphones/speakers.
The progress through the call is displayed in hours:minutes:seconds for reference, and can also be tracked by the ‘slider bar’ at the base of the playback screen.

To pause playback, click II.

To stop playback, click ■.

To begin playback part-way through a call, drag the time slider to the required point, and click ▶.

### 14.4. Saving Recordings

#### 14.4.1. Saving Single Calls from the Call List

You can save single calls individually as .mp3, .wav or .trc (Total Recall proprietary format) files.

**To save individual calls:**

1. Select the call in the call list.
2. Click 
3. Navigate to the appropriate save location.
4. Enter a filename and select the required file format.
5. Click Save.

#### 14.4.2. Saving Multiple Calls to Local Folders

You can save groups of calls (as .trc files only) to Local Folders.

**To save groups of calls:**

1. Select the calls in the call list.
   Use Ctrl + click to select multiple non-consecutive calls, and Shift + click to select multiple consecutive calls.
2. Drag the calls to the appropriate Local Folder in the Device Tree.

See Local Folders on page 39 for information about setting up Local Folders.

Calls that are dragged and dropped into Local Folders are not deleted from the recorder.

### 14.5. Emailing Recordings

You can email calls as .mp3, .wav or .trc files.

**To email calls:**

1. Select the required calls in the call list.
2. Click 📂.
3. Select the required audio format.
4. Click OK.

A blank email is created (using the system default email client) with the calls already attached.

### 14.6. Deleting Recordings

You can only delete calls from local folders.

**To delete calls from a local folder:**

1. Select the call/s in the call list.
2. Click 🗑️.

### 14.7. Notes

You can add or edit notes to calls on remote Total Recall recorders, in Local Folders, and in Network Share.

**To add or edit a note to a call:**

1. Select the note in the call list.
2. Click 📝.
   The Add Note dialog displays.
3. Type the note in the Add Notes text field. The field supports up to 80 characters.
4. Click OK.

**To delete a note from a call:**

1. Select the relevant call in the call list.
2. Click 📝.
   The Add Note dialog displays.
3. Click Clear.
4. Click OK.

### 14.8. Customizing the Call List

The call list is customizable. The available columns are:

- Date (Total Recall).
- Time (Total Recall).
- Date (Local).
- Time (Local).
To customize the call list:

1. Click [button]
2. Select the columns you want to include in the call list.
3. Click OK.

14.9. System Maintenance Options

Right clicking on a connected unit in the TR Tree will open a menu allowing you to view important information about the unit, as well to perform authorized system functions.

System Maintenance Options are only available when logged in to Remote Manager with an Administrator account.

In order to perform archive functions, compatible CD/DVD media must first be loaded into the Total Recall system, or (optionally on TR Rack) network share storage must be configured.
14.9.1. System Information

The **System Information** screen displays useful system information:

- **Software Revision** – The current software revision on the Total Recall unit.
- **Analog Channels** – The number of analog channels currently installed on the Total Recall unit.
- **VoIP & ISDN Channels** – This is not relevant to your Total Recall Desktop or Rack unit.
- **Recorder ID** – The currently assigned Recorder ID.
- **Stored Calls** – the number of individual calls currently on the call database.
- **Disk Space Used** – the percentage of Total Recalls onboard storage that is currently used.
- **Archive Device** – The current default archive device.

None of this information is user editable.

14.9.2. Archive

‘Archiving’ copies call files from the onboard system storage to another storage media, such as DVD/CD or (optionally on TR Rack) to a network location, for greater portability or long-term storage.

Calls may be archived according to certain parameters. These parameters are:
• **All Calls** – Every call on the internal database.
• **Found Calls** – The calls found in the most recent database search.
• **Unarchived Calls** – Calls that have not yet been archived to a location other than Total Recall’s onboard storage.
• **Tagged** – Calls that have been manually ‘tagged’ by users.

Please note that manually archived calls will **not** be included in any scheduled Automatic Archives.

**To archive calls:**

1. Select **Archive Calls** by right clicking on a current Total Recall unit in the left hand menu.
2. Select which calls to archive via the drop down menu. Choose to archive **All Calls**, **Found Calls**, **Unarchived Calls** or **Tagged Calls**.
3. Choose which location you would like to archive to. Select from **DVD/CD** media or **Network Location** (optional on TR Rack, if configured).
4. Select **OK**.

**14.9.3. Rebuild TR Database**

This option allows you to rebuild the call database on your Total Recall unit. A database rebuild is recommended where the system has been subjected to an improper shutdown.

Please note that recording will stop while the system is rebuilding the database.

**14.9.4. Update TR Software**

This option allows you to install an updated version of Total Recall software on your system. You need a Total Recall Application CD to upgrade the software on the system.

**To upgrade your Total Recall Software:**

1. Insert the Total Recall Application CD in the CD/DVD drive on the PC which runs Remote Manager.
2. Select **Upgrade TR Software** via right clicking on a current Total Recall unit in the left hand menu.
3. Select the Total Recall Application package (**.tgz** format) on the application CD as shown on the following screen capture:
4. Click on the **Open** button, then follow the screen prompts to complete the upgrade.

   Note that the **Total Recall** system will automatically reboot itself during the upgrade process. Recording does not continue during the upgrade process and while the system is rebooting, which may take up to 5 minutes to complete.

   The upgrade function only affects application and operating system files. However, as an extra precaution it is recommended that you back up all important calls from the call database before you perform an upgrade.

   Your passwords and system settings are not affected by updating the system software.

### 14.9.5. Load TR Settings

This option allows you to restore the **Total Recall** system configuration from a file that is stored on the hard drive of your **Remote Manager** PC.

**To load TR Settings from a saved configuration file**

1. Select **Load TR Settings** by right clicking the **Total Recall** unit in the Device Tree.

2. Navigate to a previously saved configuration file on your hard drive. Click on the file, and then click **Open**.

3. Follow the on-screen prompts to load the new settings.

### 14.9.6. Save TR Settings

This option allows you to backup the current system configuration to a file that can be stored on your PC hard drive. This saved configuration can be used to restore your system to a previous configuration if required.

**To save TR Settings in a configuration file**

1. Select **Save TR Settings** by right clicking the **Total Recall** unit in the Device Tree.

2. Navigate to the folder on your hard drive where you would like to save the configuration file. Define a name for your saved configuration, then click **Save**.
14.9.7. Shutdown

This option allows you to remotely shutdown the system.

Note that the system will power off and recording will not continue until you restore power to the system.

15. Event Log Tab

Use the Event Log tab to view a record of system events for the selected recorder.

15.1. Event Types

The Event Log may contain 3 types of event:

Information

Information events are standard system events and do not require any further action.

Warnings

Warnings are events that may indicate possible future problems, and should be investigated – for example, failed database searches and power failures.

Errors

Errors are events that must be investigated immediately, such as database rebuild failures, auto-archive failures, and DSP card issues.

15.2. Using the Event Log

To filter the displayed entries in the Event Log, click the button for the event type that you wish to view.

To refresh the Event Log, click .
The Event Log can hold approximately 100,000 entries. When the Event Log is full, new entries automatically overwrite old entries.

The contents of the Event Log can be selected and copied out into a text editor to allow keyword searches.
Record on Demand

16. Overview

Record on Demand (ROD) is an optional Windows®-compatible client application that provides additional real-time recording control to Total Recall end users (usually agents). Record on Demand is supplied on CD free-of-charge with all Total Recall systems, for installation and use on as many PCs as required.

Utilizing an existing LAN connection, users can start and stop the recording of current calls, control which calls on their line are recorded and which aren’t, and add notes to current calls – all from a simple taskbar application on the user’s PC.

If a user requires ROD functionality but does not have immediate access to a PC, recording can also be controlled by the use of configurable DTMF codes entered on a user’s phone.

ROD functionality is configured (either as a ‘global’ setting across all extensions, or on an individual extension basis) on the Total Recall unit itself, or in Remote Manager.

16.1. Installation and Initial Configuration

ROD should only be installed and configured by a system administrator.

☞ See the Total Recall Installation and Administration Guide for information about installing ROD.
17. Using ROD

17.1. Logging In

To log in to ROD:

1. Start the ROD application (double-click the desktop icon, or select TR Record on Demand from the Windows Start menu).

2. Select your Agent Name from the drop-down list.

3. Click Login.

4. Enter your password.

5. Click OK.

ROD can now be used to control recording (and/or add notes to calls) on the configured extension.

17.2. Recording

To toggle recording on and off, click the recording button.

When the recorder is not recording, the record button is labeled ‘Not Recording’ and appears in the ‘up’ state:

![Not Recording]

When the recorder is recording, the record button is labeled ‘Recording’ and appears in the ‘down’ state, with a flashing red LED icon:

![Recording]

17.3. Logout and Refresh

To log out, click Logout.

As a security measure, it is advisable to log out whenever you leave your PC.

If new agents have been added whilst ROD is open, click Refresh to update the agent list.

17.4. Adding Notes

To add a note to a current call:

1. Type the note into the text box. The text box supports up to 256 characters.

2. Click Add Note.
17.5. Configuration

The Configure button allows access to the Total Recall connection details and the recorded extension setting.

Only users with administrator privileges can access the Configuration dialog.

☞ See the Total Recall Installation and Administration Guide for information about configuring ROD.
Glossary

**CLI: Calling Line Identification**

A telephony intelligent network service that transmits the caller's telephone number and in some places the caller's name to the called party's telephone equipment during the ringing signal or when the call is being set up but before the call is answered.

**CDR: Call Detail Record**

Also called Call Detail Recording or SMDR (Station Message Detail Recording), CDR is a record containing information about recent system usage, including the identities of sources (points of origin), the identities of destinations (endpoints), and the duration of each call.

**D/A: Digital to Analog**

A digital-to-analog converter (DAC or D-to-A) is a device for converting a digital (usually binary) code to an analog signal (current, voltage or electric charge).

**DSP: Digital Signal Processor**

A specialized microprocessor designed specifically for digital signal processing, generally in real-time computing.

**DTMF: Dual-Tone Multi-Frequency**

Used for telephone signaling over the line in the voice-frequency band to the call switching center. The version of DTMF used for telephone tone dialing is known by the trademarked term Touch-Tone, and is standardized by ITU-T Recommendation Q.23. Other multi-frequency systems are used for signaling internal to the telephone network.

**FTP: File Transfer Protocol**

A commonly used protocol for exchanging files over any network that supports the TCP/IP protocol (such as the Internet or an intranet).

**IDF: Intermediate Distribution Frame**

A frame that (a) cross-connects the user cable media to individual user line circuits and (b) may serve as a distribution point for multi-pair cables from the main distribution frame (MDF) or combined distribution frame (CDF) to individual cables connected to equipment in areas remote from these frames.

**IP: Internet Protocol**

A data-oriented protocol used for communicating data across a packet-switched internetwork.

IP is a network layer protocol in the internet protocol suite and is encapsulated in a data link layer protocol (e.g., Ethernet). As a lower layer protocol, IP provides the service of communicable unique global addressing amongst computers.
**LAN: Local Area Network**
A computer network covering a small geographic area, like a home, office, or group of buildings.

**LCD: Liquid Crystal Display**
A thin, flat display device made up of any number of color or monochrome pixels arrayed in front of a light source or reflector.

**MDF: Main Distribution Frame**
A signal distribution frame for connecting equipment (inside plant) to cables and subscriber carrier equipment (outside plant).

**NTP: Network Time Protocol**
A protocol for synchronizing the clocks of computer systems over packet-switched, variable-latency data networks. NTP uses UDP port 123 as its transport layer. It is designed particularly to resist the effects of variable latency (Jitter).

**PBX: Private Branch Exchange**
Also called Private Business eXchange, or PABX (Private Automatic Branch eXchange), a PBX is a telephone exchange that serves a particular business or office, as opposed to one a common carrier or telephone company operates for many businesses or for the general public.

**PSTN: Public Switched Telephone Network**
The network of the world's public circuit-switched telephone networks.

**QoS: Quality of Service**
Control mechanisms that can provide different priority to different users or data flows, or guarantee a certain level of performance to a data flow in accordance with requests from the application program.

**RTP: Real-time Transport Protocol**
The Real-time Transport Protocol (or RTP) defines a standardized packet format for delivering audio and video over the Internet.

**SMDR: Station Message Detail Record**
SMDR is a record containing information about recent system usage, including the identities of sources (points of origin), the identities of destinations (endpoints), and the duration of each call.

**TCP: Transmission Control Protocol**
One of the core protocols of the Internet protocol suite, often simply referred to as TCP/IP. Using TCP, applications on networked hosts can create connections to one another, over which they can exchange streams of data using Stream Sockets.
**UDP: User Datagram Protocol**

The User Datagram Protocol (UDP) is one of the core protocols of the Internet protocol suite. Using UDP, programs on networked computers can send short messages sometimes known as datagrams (using Datagram Sockets) to one another. UDP is sometimes called the Universal Datagram Protocol.

**UPS: Uninterruptible Power Supply**

A device which maintains a continuous supply of electric power to connected equipment by supplying power from a separate source when utility power is not available.

**VLAN: Virtual LAN**

A method of creating independent logical networks within a physical network.

**VOX: Voice Operated Switch**

A vox or voice operated switch is a switch that operates when sound over a certain threshold is detected.

**WAN: Wide Area Network**

A computer network that covers a broad area (i.e., any network whose communications links cross metropolitan, regional, or national boundaries). Or, less formally, a network that uses routers and public communications links.
Specifications

Physical Specifications

6 Kg, 175 (H) x 370 (W) x 365 (D) mm (Desktop).
10 Kg, 220 (H) x 450 (W) x 230 (D) mm, 5 RU (Rack).

0 °C - 60 °C Operating & storage temperature, non-condensing.

Power

Single auto-sensing 100-240 VAC, 60-50 Hz, 180W Max PSU (Desktop & Rack).
Optional Dual Hot-Swap 110-240VAC, 50-60Hz 300W Max PSU (Rack).
Maximum power draw for Total Recall Desktop & Rack is 80W.

Telephony Interface

Analog 2-Wire POTS, FSKR, DTMF.

Voice Processing

HQVQ (8:1) Compression. WAV (16 bit, 8 KHz) & MP3 Export.

Onboard Storage Capacity

Most recent 350,000 calls or 60,000 recording hours, whichever is reached first.

Channel Capacity

24 Simultaneous Channels (Desktop).
48 Simultaneous Channels (Rack).

Recording Trigger

Off-Hook (6 different voltage levels), VOX (6 different volume levels), On-Demand (via DTMF code or PC Software).

Call Monitoring

Real-time monitoring via onboard speaker & control panel, or via Remote Manager and LAN/WAN/VPN/56k Dialup connection.

Search & Replay Controls

Via onboard speaker & control panel, or via Remote Manager embedded player & PC speakers. Start, stop, fast-forward, rewind & pause controls.

Archive Media

Network Attached Storage (NFS v2/3, CIFS/SMB) optional on TR Rack only.

Networking

One 100Mb Ethernet port, Single RS232 port (for modem connection). Network Time Synchronization via NTP.
Optional TCP/IP Alarms via SNMP, and Call Detail Record interface (TR Rack).
Limited Products Warranty

18. ComsecTR Limited Products Warranty

18.1. Our Standard Limited Warranty Period

ComsecTR warrants that Total Recall (the “Products”) conforms in all material respects to the end user documentation provided with the Products, and that the hardware components of the Products will be free from defects in materials and workmanship for a period of **13 months after the system has been shipped from the ComsecTR manufacturing facility.**

18.2. Exception for Sales Arising From Stock-Carrying Distributors/Dealers

On average, Total Recall systems are installed within 1 month of being shipped from the factory, providing end users with a minimum of 12 months warranty coverage. However, as some ComsecTR resellers carry stock this may not always be the case.

In situations where a Total Recall system has been purchased from a stock-carrying Reseller or Distributor, ComsecTR warrants that Total Recall (the “Products”) conforms in all material respects to the end user documentation provided with the Products, and that the hardware components of the Products will be free from defects in materials and workmanship for a period of **12 months after the system has been shipped from the stock-carrying Reseller or Distributor.**

Please confirm your applicable limited warranty period with the company from which you purchased the Total Recall system. ComsecTR will assume that the period set out in section 18.1 of this limited product warranty applies unless demonstrated otherwise.

18.3. Limitations of This Warranty

This limited warranty does not cover the results of accidents (including unusual physical or electrical stress), abuse, neglect, vandalism, acts of God, usage contrary to handling or operating instructions supplied by ComsecTR or repair or modification by anyone other than ComsecTR or an expressly authorized Total Recall service agent.

18.4. Handling of Faulty Parts

Please note that any faulty components replaced under the terms of this product warranty must be kept by the authorized servicing agent for verification, up to a maximum period of 12 months. If the servicing agent is unable to provide the faulty parts for which warranty replacements have been
provided, then the servicing agent will be required to pay to ComsecTR the value of the replacement parts, as determined by ComsecTR.

18.5. ComsecTR Record Keeping

Please note that all Total Recall serial numbers, and the serial numbers of internal components will be logged by ComsecTR, effective the date of shipment. The serial numbers of any replacement parts will also be logged by ComsecTR.

19. Warranty Claims and Procedure

19.1. Who to Contact

If there is reason to believe that Products do not conform to the warranty set forth in Section 18.1, the affected party should notify the company from which the Product was purchased in writing of such non-conformance, no later than ten (10) days after the end of the Warranty Period for those Products, and shall provide the following details:

1. The serial number of the affected unit(s), and;
2. Details of the non-conformance, with as much specific detail as possible.

Additional details of the non-conformance may be required as the authorized service agent or ComsecTR reasonably requests.

19.2. What Procedure Will Be Followed?

The company that you purchased the system from will, if authorized, provide the required service and/or organize the required replacement parts. If not authorized to provide this service, the company that you purchased the system from will elevate your service request to an authorized service agent. The authorized service agent may elect to further elevate the problem to ComsecTR if required. This will occur in accordance with ComsecTR’s standard procedures.

The user will be required to pay for the freight to an authorized servicing agent or ComsecTR if the Products need to be returned for servicing. The authorized servicing agent or ComsecTR will pay for the freight back to the customer if the goods are deemed to fail to conform to this warranty.

19.3. What Services Will Be Performed?

If Products are deemed to fail to conform to this warranty by an authorized servicing agent or ComsecTR, the sole remedy shall be, at the authorized servicing agent’s or ComsecTR’s option and expense:

1. The repair or replacement of the faulty component(s), and;
2. Return of the Products within fourteen (14) days after the authorized servicing agent receives the non-conforming Total Recall system. If

---

1 If the product(s) were purchased from ComsecTR directly, then ComsecTR would be the first point of contact. However, if the product(s) were purchased via an intermediary company, then your first point of contact would be that intermediary company.
the system needs to be returned to ComsecTR, an additional period of 14 days from the receipt of the unit at ComsecTR will be applicable.

Please Note: If ComsecTR or the Authorized Servicing Agent determines that returned Products do conform to this warranty, then the Products will be returned at the requesting party’s expense and risk.

19.4. Important Notice: Sole & Exclusive Remedy

NOTWITHSTANDING ANYTHING IN THIS AGREEMENT TO THE CONTRARY, THE FOREGOING IS THE SOLE AND EXCLUSIVE REMEDY FOR BREACH OF WARRANTY BY COMSEC TR WITH RESPECT TO THE PRODUCTS.

19.5. Disclaimer of Warranties

19.5.1. Important Notice: Disclaimer of Warranties

EXCEPT FOR THE LIMITED WARRANTY FOR THE PRODUCTS CONTAINED IN SECTION 18.1, COMSEC TR AND ITS SUPPLIERS AND SERVICING AGENTS DISCLAIM ALL WARRANTIES WITH RESPECT TO THE PRODUCTS, EXPRESS, IMPLIED OR STATUTORY, INCLUDING AS TO PERFORMANCE, NON-INFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
Legal

The Total Recall requires Linux kernel and modules to operate. These come from the CentOS distribution and may be covered by the GNU General Public License (GPL) which is enclosed here for your review (as obtained from http://www.gnu.org/copyleft/gpl.html).

All Total Recall software is distributed under the ComsecTR Software License.

20. ComsecTR Software License

End-User License Agreement for ComsecTR Software.

IMPORTANT - READ CAREFULLY:

This ComsecTR Software License Agreement (“CSLA”) is a legal agreement between you (either an individual or a single entity) and ComsecTR Pty Ltd for the ComsecTR software product identified above, which includes computer software and associated media and printed materials, and may include “online” or electronic documentation (“SOFTWARE PRODUCT” or “SOFTWARE”). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this CSLA. If you do not agree to the terms of this CSLA, promptly return the unused SOFTWARE PRODUCT to the place from which you obtained it.

SOFTWARE PRODUCT LICENCE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

GRANT OF LICENCE

This CSLA grants you the following rights:

The software and hardware described in this document are furnished under a license agreement and may be used only in accordance with the terms of the agreement. The software that accompanies all ComsecTR products is the property of ComsecTR Pty Ltd (ABN 40 051 658 569), and is protected by copyright law. While ComsecTR continues to own the software, you will have certain limited rights to use the software after your acceptance of this license. Except as may be modified by a license addendum which accompanies this license, your rights and obligations with respect to the use of this software are as follows:

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

Limitations on Reverse Engineering, Decompilation, and Disassembly: You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable law not withstanding this limitation.
Termination: Without prejudice to any other rights, ComsecTR may terminate this CSLA if you fail to comply with the terms and conditions of this CSLA. In such event, you must destroy all copies of the SOFTWARE PRODUCT and all of its component parts.

UPGRADES

If the SOFTWARE PRODUCT is an upgrade of a ComsecTR product, you now may use that upgraded product only in accordance with this CSLA.

COPYRIGHT

All titles and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, photographs, animations, video, audio, music, text, and “applets,” incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE PRODUCT, are owned by ComsecTR or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES

To the maximum extent permitted by applicable law, in no event shall ComsecTR or its suppliers be liable for any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use the software product, even if ComsecTR has been advised of the possibility of such damages.

MISCELLANEOUS

The developer, ComsecTR Pty Ltd has adopted a policy to continue the development of Total Recall, Remote Manager and Record on Demand and therefore there may be variations between the documentation and the operating system at any one time.

Should you have any questions concerning this CSLA, or if you desire to contact ComsecTR for any reason, please contact the ComsecTR reseller serving your country, or write to:

ComsecTR Pty Ltd
PO Box 572
Milsons Point, NSW 1565
Australia
21. GNU Public License

GNU GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

PREAMBLE

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is fundamentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

“This License” refers to version 3 of the GNU General Public License.

“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” and “recipients” may be individuals or organizations.

To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based on” the earlier work.

A “covered work” means either the unmodified Program or a work based on the Program.

To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available to the public, and in some countries other activities as well.

To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, with no transfer of a copy, is not conveying.

An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list meets this criterion.


The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any non-source form of a work.

A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a particular programming language, one that is widely used among developers working in that language.

The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to the public in source code form. A “Major Component”, in this context, means a major essential component (kernel, window system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code interpreter used to run it.

The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.


You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided that you also meet all of these conditions:

- a) The work must carry prominent notices stating that you modified it, and giving a relevant date.
- b) The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies the requirement in section 4 to "keep intact all notices."
- c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.
- d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source under the terms of this License, in one of these ways:

- a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.
- b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the Corresponding Source from a network server at no charge.
- c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.
- d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to
find the Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these requirements.

- e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product received by a particular user, “normally used” refers to a typical or common use of that class of product, regardless of the status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.

“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give appropriate copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supplement the terms of this License with terms:

- a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
- b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works containing it; or
- c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different from the original version; or
- d) Limiting the use for publicity purposes of names of licensors or authors of the material; or
- e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
- f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or conveying
under this License, you may add to a covered work material governed by the terms of that license document, provided that the
further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the
additional terms that apply to those files, or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions;
the above requirements apply either way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to
propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses
granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a)
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the
copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the
violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work)
from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from
you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new
licenses for the same material under section 10.


You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered
work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require
acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These
actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you indicate
your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify
and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this
License.

An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an
organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party to that
transaction who receives a copy of the work also receives whatever licenses to the work the party's predecessor in interest had or
could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work from the
predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example,
you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not
initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making,
using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is
based. The work thus licensed is called the contributor's “contributor version”.

A contributor's “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired or
hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its
contributor version, but do not include claims that would be infringed only as a consequence of further modification of the
contributor version. For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner consistent
with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent
claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To “grant” such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you have actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under applicable patent law.


If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License “or any later version” applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS
TOTAL RECALL

Voice Logging Recorders are distributed in the U.S.A. by:

Omnicron Electronics

581 LIBERTY HIGHWAY • P.O. BOX 623 • PUTNAM, CT 06260-0623
☎ (860) 928-0377 • FAX (860) 928-6477
support@omnicronelectronics.com
www.omnicronelectronics.com